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TIPS FOR A SUCCESSFUL INSTALLATION
These steps have been prepared to help minimize or eliminate any issues when installing the Dentrix Learning Edition. For a
successful installation, follow the steps below exactly. Please read through all the steps before attempting to install the Learning Edition.
1. Ensure System meets the System Requirements

For optimal performance with the Learning Edition, it is important to review the system requirements and make sure your
system can accommodate them before you install the Learning Edition. The Dentrix Learning Edition system requirements
are available at www.dentrix.com/training/dentrix-learning-edition.aspx.
Please be aware of the following:
•

The Dentrix Learning Edition runs on a Windows platform, and can run on only Microsoft Windows XP or higher.

•

The computer’s graphics card may need to be upgraded to take advantage of the 3-D modeling features in the
Learning Edition.

•

Adequate processor speed is important to help reduce or eliminate any latency/performance issues as they relate
to the Learning Edition. The amount of free memory on the computer can greatly impact the performance of
the computer and also the performance of the overall Dentrix system. Reducing or eliminating the number of
unnecessary processes on a computer can significantly improve a computer’s performance.

When the system requirements are closely scrutinized and adhered to, the potential for a successful installation experience
increases dramatically.
2. Check Available Disk Space

From the Start menu, select My Computer and highlight the C:\ drive icon. Select View > Details from the menu bar, or
right-click on the C:\ drive icon and select Properties. The Local Disk Properties dialog box appears. The General tab will
display the Used and Free Disk Space.
Consult the Dentrix Learning Edition System Requirements to view the required free hard disk space for workstations. The
current Dentrix system requirements are available online at www.dentrix.com/training/dentrix-learning-edition.aspx. You
may experience slowness if your system does not meet the requirements for available memory or hard drive space. If your
system is very deficient in memory, the Learning Edition might not be able to install on your system until you upgrade your
system and get more memory.
3. IMPORTANT! Close All Other Applications

Look at the Windows Notification Area (normally in the bottom, right corner of the screen, near the system time) and close
any programs that appear there. As with most programs, you must disable any antivirus software on the computer and the
Windows screensaver for the duration of the installation. When the install is complete, enable the antivirus software and the
Windows screensaver.
4. Follow the Installation Instructions

Follow the step-by-step instructions in this guide to install the Dentrix Learning Edition.
5. Finish the Installation Completely

Do not interrupt the installation process, even if it looks as though nothing is happening. You will be prompted when the
installation is ready to continue. Terminating an installation prior to completion could affect the integrity of the database.
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INSTALLING THE DENTRIX LEARNING EDITION
Read the Tips for a Successful Installation section before beginning the installation.
Depending on the version of Windows you are using, you may see messages during the installation process that are not shown
in these steps. Follow the on-screen prompts for those messages as they appear and continue with the installation as directed
in the steps below.

1. Insert the Dentrix Learning Edition DVD into the DVD drive. If the DVD drive is equipped with AutoStart technology, the Dentrix G4 Install Welcome screen appears within a few seconds (see Figure 1-1).
•

If you see the Welcome screen, proceed to step 2.

Figure 1-1

•

If the Welcome screen does not appear:

a.

Click the Windows® Start button and select Run. The Run dialog box appears.

b. Type D:\Disk1\Setup in the command line (where D: is the drive letter for the DVD drive). Click the OK button to begin the installation.
c. Click Install Software. The screen that appears lists the products you can install. From this screen, you can
install the Dentrix Learning Edition and the Required Components.
2. Click the Install Required Components install option to display the Required Components information (see Figure 1-2). Follow the instructions below to install the required components.

Figure 1-2
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a.

Click Install Now to install the required components. The InstallShield Wizard will perform a check of your
system to verify that all the required components are installed. After the InstallShield Wizard has performed the
check, a screen appears with a list of the required components and whether or not they are installed on your
system (see Figure 1-3).

If you already have all the required components installed, click Finish to close the Required Components install dialog box and
return to the main installation screen.

Figure 1-3

b. Click Install All to install all the required components. If desired, you can install each component one at a time
by clicking Install next to the component, waiting for the install to finish, and clicking Install on the next component.
As components are installed, you might receive several on-screen messages or prompts. Follow the on-screen
prompts to install the required components.
If you are installing Adobe Flash Player 9, you may see an error message during the install. Click OK to the error message. If
other components need to be installed, the installation continues.

c. Once all the required components have been installed, click the Close button (the red “X” button in the top,
right corner). An Exit Setup message appears (see Figure 1-4).

Figure 1-4

d. Click Yes on the Exit Setup message to indicate that you want to cancel the setup and return to the Required
Components information on the main install screen (see Figure 1-2).
3. Click Install Dentrix G4. The Dentrix Learning Edition installation information appears (see Figure 1-5).
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Figure 1-5

4. Click the Install Now link at the bottom of the Dentrix Learning Edition installation information. The InstallShield
Wizard loads and the Welcome screen appears (see Figure 1-6).

Figure 1-6

5. Read the Tips for a Successful Installation on this screen. When you have read the tips, mark I have read and followed the tips for a successful installation and click Next to continue. The License Agreement screen appears
(see Figure 1-7).

Figure 1-7

6. Read the Dentrix Learning Edition Software End User License Agreement. When you have read the document,
mark I accept the terms of the license agreement and click Next to continue.
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The InstallShield Wizard runs a System Requirements check. If your system meets the requirements, the Install
continues to step 8. If your system does not meet the requirements, the System Requirements Notice dialog box
appears and lists the deficiencies in your system (see Figure 1-8).

Figure 1-8

The Learning Edition system requirements are available at www.dentrix.com/training/dentrix-learning-edition.aspx.

7. If the System Requirements Notice appears, verify the system requirements. A green check mark indicates that a
component meets the requirements. A red “X” indicates that a component does not meet the requirements. Click
Yes to continue the installation without meeting the recommended system requirements. The Choose Folders
screen appears (see Figure 1-9).
If desired, you can click No to stop the installation and upgrade your system. However, that is not required for the
Dentrix Learning Edition.
The Dentrix Learning Edition may still function if your system does not meet the requirements. However, you may experience
slowness if your system does not meet the requirements for available memory or hard drive space. If your system is very
deficient in memory, the Learning Edition might not be able to install on your system until you upgrade your system and get
more memory.

Figure 1-9

8. Select the folder where you want to store the Dentrix Learning Edition program files. If you do not want to store
the program files in the folder that is recommended on the screen, you can select a new folder. Otherwise, leave the
folder location as it is.
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If you want to use the default folder location for the program files, click Next. If you want to change the program file
folder location, click Browse and navigate to the desired location. The Install Summary screen appears (see Figure
1-10).

Figure 1-10

9. Click Install to begin installing the Dentrix Learning Edition. After a few minutes, the Guru Limited Edition
Server Installation Wizard appears (see Figure 1-11).

Figure 1-11

10. Guru Limited Edition is a patient education tool that can be accessed from the Dentrix Chart. Click Next on the
Guru Limited Edition Server Welcome screen to continue with the installation. The Guru Limited Edition
license agreement appears (see Figure 1-12).
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Figure 1-12

11. Read the Guru Limited Edition Software End User License Agreement. When you have read the document, mark I
accept the terms of the license agreement and click Next to continue. The Firewall Configuration screen appears (see Figure 1-13).

Figure 1-13

12. With the commercial edition of Dentrix, the Guru Limited Edition Server needs access to a specific port in the system to function properly. Typically, this port is blocked by firewall protection.
With the Learning Edition, the Guru Limited Edition Server does not need to access this port, so you do not need to
allow Guru to change your firewall configuration. Make sure No is selected on the Firewall Configuration screen.
Click Next to continue with the installation. The Ready to Install screen appears (see Figure 1-14).
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Figure 1-14

13. Click Install to begin the Guru Limited Edition Server installation. The InstallShield Wizard Complete screen
appears when the install is finished (see Figure 1-15).

Figure 1-15

14. Click Finish to complete the Guru Limited Edition Server installation. The install continues with the rest of the
Dentrix Learning Edition installation.
After the Dentrix software has been installed, the Setup Complete screen appears (see Figure 1-16).

Figure 1-16
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15. Un-check Open the registration web page when I click ‘Finish’. You are not required to register your Dentrix
Learning Edition software.
16. Click Finish to finish the Dentrix Learning Edition installation. The InstallShield Wizard will close and you will
return to the Dentrix Learning Edition installation screen (Figure 1-5).
17. Click Exit to close the Dentrix Learning Edition installation screen. The InstallShield Wizard places six shortcuts on your Windows Desktop. These shortcuts open Dentrix modules and give you access to the Dentrix G4
User’s Guide (see Figure 1-17).

Figure 1-17

•

Appointments: Opens the Dentrix Appointment Book, the module you use to schedule patient appointments and
manage your schedule.

•

Family File: Opens the Dentrix Family File, the module you use to enter patient records and manage patient
information.

•

Ledger: Opens the Dentrix Ledger, the module you use to enter payments and manage accounts.

•

Office Manager: Opens the Dentrix Office Manager, the module you use to run reports and set up practice
defaults.

•

Patient Chart: Opens the Dentrix Patient Chart, the module you use to chart treatment and enter clinical notes.

•

Dentrix Launcher: Opens the Dentrix Launcher tool, which shows the Dentrix modules in the context of an office
and helps you open the correct module for the task you want to perform.

•

Dentrix G4 User’s Guide: Opens a PDF of the Dentrix G4 User’s Guide.

•

Productivity Pack 7 Update Guide: Opens a PDF of the guide that describes the new features that were added to
Dentrix G4 in Productivity Pack 7.

•

Productivity Pack 8 Update Guide: Opens a PDF of the guide that describes the new features that were added to
Dentrix G4 in Productivity Pack 8.
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DISABLING THE ESYNC, WEBSYNC, AND PRACTICE ASSISTANT TASK MANAGER
The eSync, WebSync, and Practice Assistant Task Manager are processes that run automatically with the commercial edition
of Dentrix G4. You do not need to use these processes with the Dentrix Learning Edition. It is recommended that you disable these processes to prevent them from running automatically.
If you don’t disable these processes, you will receive notifications when the eSync and WebSync run automatically. If you
don’t disable the Practice Assistant Manager, you will receive error messages when you try to shut down your computer. Follow the instructions in the sections below to disable the eSync, Websync, and Practice Assistant Task Manager.
DISABLING THE ESYNC
eSync is the process by which information is passed between the commercial edition of Dentrix and some of the Dentrix
add-on features that are not available with the Learning Edition. It is important to disable this process and prevent it from
running automatically with the Learning Edition.
If you do not disable eSync, it will run automatically and you will receive eSync notifications daily. It is important to disable
eSync to prevent it from running automatically.

The eSync setup is located in your computer’s Notification Area. The eSync icon looks like a white ‘e’ in a red circle (see
Figure 1-18).

Figure 1-18

Follow the steps below to prevent the eSync from running automatically:
1. Locate the eSync icon in the Windows Notification Area. If the icon appears in the Notification Area, skip to step 2.
If the icon does not appear in the Notification Area, follow steps a – b.
a.

Click the Windows Start button, select All Programs, and select Startup from the menu.

b. Select eSync Reminder from the Startup menu. The eSync icon appears in the Notification Area.
2. Right-click the eSync icon and select Open eSync Setup. The eSync Setup dialog box appears (see Figure 1-19).
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Figure 1-19

3. To prevent eSync from running automatically every day, mark Run eSync Manually. Do not change the other settings in the dialog box.
4. Click OK to the confirmation message that appears.
5. Click OK to close the eSync Setup dialog box. The eSync process is now disabled.
eSync is set to start up each time you restart your computer and run in the background while you work. This is beneficial for
offices because they need to use the eSync functionality throughout the day. Since you do not need to use eSync, you can
remove it from your Windows Startup folder and prevent it from starting up and running.
To remove eSync from your Startup folder, click the Windows Start button and click All Programs. Right-click the folder called
Startup and click Open All Users. In the folder that opens, right-click the eSync icon (Figure 1-21) and click Delete. Click Yes to
the message that appears. eSync will be deleted from the Windows Startup tasks and will not open on your computer again.

DISABLING THE WEBSYNC
WebSync is the process through which information is transferred between Dentrix and eCentral with the commercial edition
of Dentrix. It is important to disable this process and prevent it from running automatically with the Learning Edition.
If you do not disable the WebSync, it will run automatically and you will receive WebSync notifications daily. It is important to
disable the WebSync to prevent it from running automatically.

The WebSync Reminder icon is located in your Notification Area. The icon looks like a world with red and blue arrows
around it (see Figure 1-20).
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Figure 1-20

Follow the steps below to prevent WebSync from running automatically:
1. Locate the WebSync Reminder icon in the Notification Area. If the icon appears in the Notification Area, skip to
step 2. If the icon does not appear in the Notification Area, follow steps a – b.
a.

Click the Windows Start button, select All Programs, and select Startup from the menu.

b. Select WebSync Reminder from the Startup menu. The WebSync Reminder icon appears in the Notification
Area.
2. Right-click the WebSync Reminder icon and select Open the DXWeb Toolbar. The DXWeb Toolbar appears
(see Figure 1-21).
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Figure 1-21

3. Click the Settings button (see Figure 1-22) and select WebSync Wizard from the menu.

Figure 1-22

4. Click Next on the WebSync Wizard Welcome screen (see Figure 1-23).
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Figure 1-23

5. Mark Do Not Run WebSync Automatically in the Schedule Websync section of the WebSync screen (see Figure
1-24). Do not change the rest of the settings on the screen.

Figure 1-24

6. Click Next on each subsequent screen until you get to the end of the Wizard.
7. Click Finish to close the WebSync Wizard.
8. Click the small “X” in the bottom right, corner of the DXWeb Toolbar to close it.
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WebSync is set to start up each time you restart your computer and run in the background while you work. This is beneficial for
offices because they need to use the WebSync functionality throughout the day. Since you do not need to use WebSync, you
can remove it from your Windows Startup folder and prevent it from starting up and running.
To remove WebSync from your Startup folder, click the Windows Start button and click All Programs. Right-click the folder
called Startup and click Open All Users. In the folder that opens, right-click the eSync icon (Figure 1-29) and click Delete.
Click Yes to the message that appears. WebSync will be deleted from the Windows Startup tasks and will not open on your
computer again.

DISABLING THE PRACTICE ASSISTANT TASK MANAGER
The Practice Assistant Task Manager is used by the Dentrix Practice Assistant to schedule reports to be generated at a specific time. This manager runs by default when you start up your computer. In a dental office it’s important for the manager
to be running so that the correct reports are generated at the scheduled time. However, because you will not be scheduling
reports to run automatically with the Dentrix Learning Edition, you will not need to run the Practice Assistant Task Manager. Instead, you should disable the manager.
You will not see any messages from the Practice Assistant Task Manager until you shut down your computer. The Practice
Assistant Task Manager does not shut down automatically, and it will display a warning message when you try to shut down
the computer (Figure 1-25). After you dismiss that message, while the computer is shutting down it, you may see a message
telling you that a program is running and you have to force it to close, and it will list the Practice Assistant Task Manager
(Figure 1-26)

Figure 1-25

Figure 1-26
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It’s important to disable the Practice Assistant Task Manager so you don’t receive warning messages about the Practice
Assistant when you shut down your computer.

Follow the steps below to disable the Practice Assistant Task Manager:
1. Locate the Practice Assistant Task Manager icon in the Windows Notification Area (Figure 1-27). If the icon appears in the Notification Area, skip to step 2. If the icon does not appear in the Notification Area, follow steps a – b.
a.

Click the Windows Start button, select All Programs, and select Startup from the menu.

b. Select PA Manager from the Startup menu. The Practice Assistant Task Manager icon appears in the Notification Area.

Figure 1-27

2. Double click the Practice Assistant Task Manager icon. The Practice Assistant Task Manager dialog box appears (Figure 1-28).

Figure 1-28

3. Un-check the Display Shut Down Message option. This will prevent you from receiving a warning message when
you shut down your computer.
Dentrix Learning Edition Installation Instructions

18

4. Click the close button (the X) in the top, right corner of the dialog box to close it.
The Apply button in the dialog box may be grayed out. You do not need to click Apply in order to save the changes; you just
need to check the option and close the dialog box.

5. Once you have disabled the shut down message, right click the Practice Assistant Task Manager icon in the Notification Area and click Close Practice Assistant Manager.
The Practice Assistant Task Manager is set to start up each time you restart your computer. You will not see the message like
Figure 1-25 at shut down if you have followed the steps above, but you may still see a message like Figure 1-26 telling you that
the program is still running in the background. If you do not want to see that message, you can remove the Practice Assistant
Task Manager from your Startup folder.
To remove the Practice Assistant from your Startup folder, click the Windows Start button and click All Programs. Right-click
the folder called Startup and click Open All Users. In the folder that opens, right-click the Practice Assistant Task Manager
icon (Figure 1-27) and click Delete. Click Yes to the message that appears. The Practice Assistant Task Manager will be deleted
from the Windows Startup tasks and will not open on your computer again.
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Congratulations! You have installed your copy of the Dentrix Learning Edition. If you need help, you can use any of the
resources listed below.
ON-DEMAND TRAINING
Additional information, including on-demand software tutorials, can be found on the On-Demand Training web page. Our
tutorials explain fundamental concepts and guide you through hands-on practice exercises. You can even check your understanding with simple quizzes.
To access on-demand training, from any Dentrix module, click Help > On-Demand Training. If you have an Internet connection, the On-Demand Training web page opens.
HELP FILES
To access the Help files, open any module and click Help > Contents. The Dentrix Help window appears. In the Help, you
can use the navigation Tree on the Contents tab to find a feature in a specific module. Or, you can type key words in the filed
on the Search tab to get a list of Help topics.
USER’S GUIDE
The Dentrix G4 User’s Guide is provided in electronic format on the Dentrix Learning Edition DVD and is saved on the
Windows Desktop when you install the Learning Edition. With electronic documentation, you can quickly search for the
information you need.
DENTRIX NEWSLETTER
The Dentrix eNewsletter provides Dentrix tips, articles about the dental business, important product announcements and
more. When you register for the eNewsletter, you’ll receive a free eNewsletter in your email inbox once a month. Browse to
http://dentrix.com/eNewsletter to register for the Dentrix eNewsletter.
DENTRIX MAGAZINE
Dentrix Magazine is a quarterly publication that provides Dentrix news, tips and case studies to help Dentrix offices build
more efficient and profitable dental practices. Free copies of the magazine are available for download (PDF). Browse to
http://dentrix.com/training/dentrix-magazine to visit the Dentrix Magazine page.
FACEBOOK
Join the Dentrix fan community on Facebook. Get weekly tips about using Dentrix and chat with other Dentrix users. Log in
to Facebook and “Like” Dentrix.

Thank you for purchasing the Dentrix Learning Edition. We hope you will enjoy using it to explore and practice the many
features of Dentrix.
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